
Graphic Maps 

Standard Graphic Maps: 

With a working map on screen, click Settings button to set style and 
color options for the standard graphic maps. These settings are 
remembered and will provide consistent, standard high-resolution 
graphic maps until changed.  

For special features, click to select feature and click Tools, Customize 
Feature Style to set custom feature style or color for this one feature. 

Click Content tab on Settings dialog box to select a map style that adds 
descriptive text to the map page, a good choice for your notebook. 

Enhanced Views: 

With a working map on screen, click Enhanced View button and 
select New View to create a special graphic map that you can 
customize to use for a presentation or publication. Drag lower right 
corner to increase size of map window. Delete non-essential enzyme sites 
or features in this view without removing them from your molecule file. 

Basic Settings -- click Settings, Map Basics to set basic options for the 
molecule map (format, size, basepair intervals, line widths).  

Click Settings, Feature Basics to set feature font styles and colors.  

Click Settings, Enzyme/primer/label Site Basics to set fonts and colors for 
map sites, or to show basepair numbers or italicize the first three letters of 
enzyme names. 

Special Feature settings -- click on a feature to select. Then use 
toolbar buttons to change position, style, pattern, color for this one 
feature. Drag feature name to reposition, if needed. 

Text -- click on text to select and then use toolbar controls to change font 
face, point size, color. All enzyme names use the same font and color; all 
feature names use the same font but can be in different colors. 

Save Enhanced View -- click Save or Send button to save this enhanced 
view to the molecule file (maximum 6 per file). Remember to save the 
modified molecule file to disk before exiting the program. 

Print, Copy, Export Maps: 

Click toolbar Print button to send the standard or enhanced view graphic 
map to your printer.  

Click toolbar Send View to Clipboard button to copy the map for use in 
other applications. Use Edit, Paste Special to paste map into a word 
processing document.  

Click toolbar Send View to File button to prepare a Windows Metafile (emf 
or wmf) for use in other Windows applications.  

Click button Save for Web on map window toolbar to prepare a 
raster graphic file in png format for web page or on-screen 
presentations. 

For enhanced views, click Save or Send button in enhanced view window 
to copy to the clipboard or export to file in vector (wmf, emf) or raster 
(GIF, TIF, PNG) formats at high or low resolution. 
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Quick Reference 

Getting Started 

To install an individual or workgroup copy, insert the program CD in drive and 
allow disk to autorun. Follow the instructions on your screen. 

Double-click the Clone Manager icon to start the program. 

Getting Help -- click File, Help or use toolbar Help button to view 
complete application help. In Help, click Show to open Search pane 
to find topics with specific keywords. 

Click File, Preferences to set author name, default save format, or features to 
import when loading files in GenBank or EMBL formats.  

for Windows 

Working with Molecules 

Open Files -- Load Molecules: 

Click File, Open or use Open toolbar button. Use Shift or Control keys in 
conjunction with mouse to open more than one file at the same time. 

Information on the clipboard can be read as if it were a disk file using File, 
Other Tools > Import from Clipboard. Or use the Paste Sequence option 
found in the New Molecule dialog box. 

Click File, Other Tools > Retrieve from Entrez eUtils to find sequence files 
at the NCBI. With the search results on the screen, click to select a file. 
Click button Show GenBank File to view or Get Molecule to import 
molecule for immediate use. 

Click Find in Files toolbar button to locate molecule files containing 
specified feature or text. 

Creating new molecules: 

Click File, New and then follow the wizard instructions to create a new 
molecule. Save new molecule to disk when complete. 

Selecting molecules: 

Active molecule is in active window (dark title bar). Click on a different 
window to change the active molecule or select from Molecule List. 

Click Molecule List toolbar button to access list of loaded molecules.   
Click More Info/Less Info to display or hide additional information 
that can help you select the needed molecule. Asterisk symbol marks 
unsaved new or modified molecules. 
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Enzyme Operations 

Find Enzyme sites: 
Click Clone, Find Enzyme Sites to find sites for specific enzymes or all 
enzymes on a list that meet a specific requirement (like single cutters) or all 
enzymes on a user list. 

View or build enzyme lists: 
To view, click Enzyme Lists toolbar button. To edit a user list, click 
the Edit User List button, unlock the list and then add or delete 
enzymes. To build a new user list, click the Build User List button. 

REBASE updates: 
Click Enzyme Lists and then click the REBASE Update button to 
update your master enzyme file using the latest REBASE data file 
(updated monthly). Each time you update, the Commercial (Main), 
All Enzymes, and Scanner enzyme lists will be regenerated. User enzyme 
lists and any special enzymes you entered will not be affected. 

Instant enzyme information: 
Click toolbar buttons on the Map, RMap or Enzyme List displays to view 
enzyme information (Properties, Suppliers, Isoschizomers or Compatible 
Ends). Enzyme information is updated when you do a REBASE update. 

Cloning Operations 

Cut molecules: 
Click Clone, Cut or use button on ligate display to cut a molecule with 
specific enzymes, cut at a single map site, or cut at specified bp positions. 

Modify molecule ends: 
Click Clone, Modify Ends or use button on ligate display. Use Klenow Fill-
In, 5'->3' or 3'->5' exonuclease, Partial Fill-In, or custom modification. 

Ligate molecules: 
Click Clone, Ligate to join together two or more pieces of DNA or join 
the ends of the same molecule (self-ligate). Use toolbar buttons to add 
or move molecules so that fragments are in order of ligation. Small 
icons appear between fragment boxes to indicate if ligation is possible.  

Click on a fragment to make it active (appears in upper window), then use 
buttons to cut, modify ends, or invert molecule as needed for ligation.   

Use the Cloning Wizards: 
Click Clone, Plan Cloning  to define what you want to clone and which 
vector to use. Set your enzyme and cloning preferences (or use default 
settings). Review the possible solutions listed, construct the recombinant of 
choice, or redefine the procedure. 

Click Clone then select Gateway Cloning, Topoisomerase Cloning, or one 
of the assembly cloning wizards to simulate cloning using these techniques. 
Use the Ligation-Independent Cloning wizard to join fragments previously 
prepared with correct overlaps. Use the Gibson Cloning or In-Fusion 
cloning wizards to use PCR to create amplified fragments with overlaps.  

The wizards will help you select the appropriate components, show you the 
proposed result, and create the final recombinant molecule. 

Molecule Viewer Window 

Click tabs at the bottom of the window to see molecule Map, Restriction Map 
data, Sequence, Features or molecule Information. Click Zoom button in tab 
region (left) to temporarily view just a part of the molecule. 

Map Tab -- Working Map display  
Enzyme sites, primer sites and label sites can appear on the working 
map along with features (genes, regions, markers). Click Change 
Sites button to select. 

Point to a site or feature on the map to see basepair position information 
and suppressed enzyme sites in crowded areas (++ notation), if present. 
Click on site or feature and then use toolbar buttons to view site properties, 
go to sequence at site, or take other action. 

Click Find button to Find Enzyme Sites (AutoScan) to scan for enzyme 
sites, Find ORFs to locate open reading frames, enter as genes.  

Click Enhanced View button then select New View to start an 
enhanced map of this molecule.   

Click Settings button, Screen Basics to set working map display options. 

RMap Tab -- Restriction Map data  
Click column headers to sort by enzyme name or number of sites. Click 
Select View button to select display style, including No Cutters (enzymes 
that do not cut this molecule). Select a different enzyme list and regenerate 
restriction map data. 

Click Settings button to set display styles and remember settings. Click 
Filter button to set filter options to limit data displayed. Click again to 
remove filter. Click on an enzyme and then use toolbar buttons to view 
enzyme properties, suppliers, isoschizomers or compatible ends informa-
tion. Click Tools to add enzyme sites to the map, or cut with this enzyme. 

Sequence Tab -- Sequence data 
View, edit or format molecule sequence. Click Settings button to set 
sequence display styles and colors and memorize settings. Click My 
Style button to format sequence using your memorized settings. 

Edit sequence -- click the Edit Sequence button to change the sequence by 
adding or removing bases. You can also use cut, copy and paste operations 
on sequence data. Sequence is stored in the program single-stranded and all 
operations work on the upper strand of sequence. 

Features Tab -- Features table 
Click Features tab to view features table and add or edit information about 
molecule features. Click Feature properties button to see codon usage, 
amino acid composition, molecular weight and pI for gene translation 
products. Click GB Location/Qualifiers button see join segment data. 

Click Customize button to set custom feature styles for map or 
sequence. Click Settings button to display or hide information-only 
features. Click Filter to limit by feature type or location.  

Info Tab -- Molecule information 
Click Info tab to view or edit molecule name, description, translation table 
setting, notes, starting bp number, or view molecule composition. 



Designing Primers 

Click Primer, Design to get started. Set option to Search for Primers or Create 
from Molecule, set primer type, enter primer length, click Next. Change 
molecule, if necessary and then follow instructions below. 

Search for Primers: 
Enter target region or position and set search option. Primers found 
are listed. Sort by rank (quality) or position. Click Primer Report 
button to open primer viewer for information or analyses.  
Click Search Results/Search Stats button to review search summary. 
Click Auto Adjust Length or Auto Adjust Criteria to find more 
primers by repeating search with adjusted length or criteria settings. 

Create from Molecule (display in sequence): 
Enter target position for initial placement. Primer viewer window opens 
and shows primer and molecule sequence. Map appears above sequence. 
Ticks on top line mark locations of neighboring primers that will meet 
criteria. Evaluation bar appears below primer. Click on value to see details 
on page in Analyze tab. Click Edit tab to return. Use toolbar buttons to 
move primer or adjust length until primer meets criteria set.  

Direct Entry of primer: 
Click Primer, Direct Entry to start wizard. Enter primer name, type, primer 
sequence. When complete, view primer in primer viewer window.  

With primer open in primer viewer window, click Add to Collection button to 
save to a primer collection or click File, Save to save new primer to disk file. 
Click Discover, Scan for molecules with Primer Sites to scan your molecule 
collection to see if this new primer will bind effectively to any of the scanned 
molecules. 

Use Sequencing Primer Wizard: 
Click Primer, Sequencing Wizard to design a set of primers. Specify 
primer type, optimal primer length, preferred primer spacing. When 
set of primers designed, use toolbar buttons to export all primer 
sequences or create a new primer collection.  

Primer Collections 

Click on Primer List to open. In left panel, click My Collections then 
select a collection file. Primers in file shown in right panel. Sort using 
column headers, resize columns or window by dragging with mouse. 

With highlight bar on primer, use toolbar buttons to view/edit this primer entry 
or export the primer sequence. Click Select button (lower right) to use this 
primer in a current operation or to open in primer viewer window. Click Add 
New Entry toolbar button to create new primer entry in place in the collection. 

Click Folder Tools toolbar button to add new folders or new empty 
collection files or to rename or delete collection files or folders. 

Search collection -- type in text to search for in Find edit box (lower left) 
and click Go button. New, transient folder Search Results will list primers 
found.  

Viewing Alignment Results 

Results are displayed in a comprehensive, tabbed viewing window and can be 
printed, copied to the Windows clipboard or exported to a disk file.  

Info tab -- contains alignment summary information table (multiple sequence 
alignments) or list of homologies found (local homology searches or scans for 
similarity). Sort list by score, percent matches, length or start position. 

Picture tab -- shows phylogeny dendrogram (multi-way alignment) or picture 
view of list of homologies found (local homology searches).  

Sequence tab -- shows aligned sequences for entire alignment of 
multiple sequences. Click Show Similarity or Difference button to toggle 
between formats emphasizing the similarities or differences between the 
sequences. Click Settings button to access full set of sequence formats 
and page style options.  

For local homology search results, sequence tab shows aligned 
sequences for the selected homology block. Click Next Result or 
Previous Result button to move through results list.  

LMap tab -- shows similarity maps for multiple sequence alignments. Click 
Tools, Compress View to fit more data in the results window. Point with 
mouse and click to see basepair position number for area of interest on map.  

For local homology search results, map tab shows a detailed location map for 
the selected homology block. 

Sequence Assembly 

Click Align, Sequence Assembly. Set Simple or Complex sequence assembly 
option and click Next to specify location of sequence files and set assembly 
parameters. Or set Subclones option to locate clones on a reference sequence. 

Sequence assembly results are shown in a data window with multiple views. 
Resize display areas using mouse. If more than one contig results, use 
the combo box in the toolbar to select contig data to view. Click Select 
View toolbar button to select: 

View Info -- review a table of results information. 

View Picture -- display graphic picture of alignment locations. Blue bars align 
5' to 3', light red bars align in reverse direction (3' to 5'). For Subclone results, 
black bars indicate gaps in coverage in normal or complement strands. 

View Sequence -- view aligned sequences with optional accessory data 
in a split pane. Non-matching bases shown in red, ambiguous bases in 
consensus shown in light blue. Click toolbar button to color bases or 
background. 

Sequence and Overview -- add assembly overview to sequence view. Brackets 
mark position and extent of sequence display. Click to set new location. 

Sequence and Coverage -- add coverage histogram below sequences. 

Sequence and Trace -- add trace data below sequence (if available). Click on 
base to show trace. Use sequence scroll bars to scroll sequence and trace data. 



Primer Operations 

Create Product: 
Found on Primer menu. Create a new DNA molecule that is the 
amplified product of a PCR-type reaction using two primers and a 
molecule that you specify. Or use toolbar button where available. 

Find Primer Sites: 
Found on Discover menu or use toolbar button in map window.  
Find sites where your primers could bind effectively to the active 
molecule. You can also add primer sites to the molecule for display 
on map or sequence. 

Display and Use Primer Sites: 
On map, click Change Sites toolbar button to switch to primer sites. 
Click on a primer site and then use Tools button to export primer 
sequence, create primer or product, or change primer name.  

To display in sequence, click Sequence tab, then click Settings button. On 
Style tab, check Primer Sites and then select display style. Select primer 
site colors on Color tab. 

Link to Molecule: 
Found on Info or Details tab in primer viewer window. Click Link 
to Molecule button to link a primer copy to the specified molecule 
or to add the primer site to the molecule map. 

Analyzing Primers 

To analyze one primer, select primer from Primer List to open primer viewer 
window and click Analyze tab. Or click Primer Report button from search list. 
You can also click Primer, Analyze and select one or two primers to analyze.  

Click toolbar buttons on Analyze tab for:  

 Primer Reports — general analysis information summary 
 Dimers  — homologies between primers (primer dimers) 
 Cautions — summary of Stability, GC Clamp, Runs of bases,  
      Repeats, Hairpins analyses 
 False Priming or Any Homologies  — 3'-end homologies or any  
           significant homologies between primer and template 

Analyze Mix Wizard: 

Found on Primer menu. Use wizard to identify list of primers and 
molecules and set parameters for analysis. Analyze possible products 
formed, binding sites found, and analysis cautions noted (primer dimers 
that might affect results or molecules or primers not used.) 

Primer Values Profile: 
Click Tools menu, Primer Values profile. Calculates Tm, GC content and 
stability for primers of specified length and plots values. 

Mutagenesis Profile: 
Click Tools, Mutagenesis profile. View sequence, enzyme recognition 
sites, translation and effect of mutation. Find 'almost' enzyme sites, 
construct mutants, create primers with mutation. 

Aligning Sequences 

Use Align menu to select options to align multiple sequences, compare two 
sequences, scan for sequence similarity, or initiate remote (BLAST) searches 
using the NCBI BLAST server. 

Align Multiple Sequences: 
Click Align Multiple Sequences. Select type of alignment, set sequence 
type (DNA or amino acid) and select scoring matrix.  

Align sequences against a reference sequence or do a multi-way alignment 
of all sequences and progressive assembly of alignments. 

Click Next to identify sequences to align. Click Add Molecule button at 
right and select sequences or group. Use up or down arrow buttons 
to move sequences within list. Click Identify Region button to 
align less than full molecule. Click Finish to start the alignment. 

Compare Two Sequences: 
Click Compare Two Sequences. Select type of comparison, sequence type 
(DNA or amino acid), and set method or scoring matrix.  

FastScan uses rapid search lookup table method. MaxScore favors finding 
high scoring regions. MaxQual favors finding shorter regions of higher 
homology. Needleman-Wunsch uses exhaustive base-by-base comparisons 
to find long regions of homology, even if they have numerous mismatches. 

Click Next to identify sequences to compare. For Sequence box 1, click 
Change... button at right and select sequence from molecule list. Repeat for 
Sequence box 2. 

Scan for Similarity: 
Click Scan for Similarity. Click New Search and identify the query 
sequence (search molecule name and region). Set translation option and 
click Next to identify files or folders to scan. 

Click Add Folder button to select a folder location to add to the search list. 
(Subfolders are included.) Click Add File button to select a library 
file to add to the search list. Click Save List button if you want to 
use the same search locations for later scans. 

Set scan options -- Set Speed to make the search more or less sensitive. Set 
lower Cutoff to accept results of lower significance. 

Use Tools, Scan Results Wizard to select molecules to load for use now, 
extract molecules from a database file for use later, or set up a multiple 
sequence alignment, using the scan results as a starting point. 

Remote Searches: 
Click BLAST Search (NCBI REST). Select the BLAST program to use and 
the BLAST database to search. You need an internet connection to send 
search requests to the NCBI BLAST server.   

Results are displayed in a table format. Use toolbar buttons to view a 
GenBank file or export the results table. Click Get Molecule button 
to import molecule in GenBank format for use now. 


